TOP

SYSTEMS INC.

Plug-In How-To Guide
Microsoft Word XP - 2003

Copyright © Topaz Systems Inc. All rights reserved.

For Topaz Systems, Inc. trademarks and patents, visit www.topazsystems.com/legal.



http://www.topazsystems.com/termsconditions.html

MS Word Plug-Ins (XP — 2003)

SYSTEMS INC.
Table of Contents

OVBIVIBW ...ttt ettt e oo oottt e e e o4 e e e bt ettt e e e e e e e e bbb e e e et e e e e e e aannnnr e e e e e e e s 3
SIGNING TN MS WOTA ... 3
Y= u T g lo L= Tod o IR o U1 1 Y2 4
Adding Topaz as a Trusted PUBliSher..........ooe 5
YKo T = U T =N od = ol =1 o 1 =T o U 6
NAMING SIGNATUIES ..eiiiiiiiiiiiiiiii ittt ettt ettt ettt ettt ettt ettt ettt et ettt eeeeeeeeeeeeeeeeeeeeees 8
Changing the Size of a Signature Field ... 9
Pre-Placing Blank Signature FIelds ... 9
Validating SIGNATUIES .....cooiiiiiiiiiiiiiei ettt 10
Auto-Validation and Voided SIgNatUres ............oiiiiieeiiiiiicee e 11
Location of the TOPAZSIG3.DOT Fil@....ccoiiiiiiiiiiiiiiiiiiiiiiiieeeeeeeeeeeeeeeeeeeeeeeeeeeeeeeeeeeeeee e 12
TroUDBIESNOOTING TIPS oo 13

2 www.topazsystems.com Back to Top



MS Word Plug-Ins (XP — 2003)
SYSTEMS INC.

Overview

The Topaz MS Office Plug-In software allows users to electronically capture a handwritten
signature in a Microsoft Word document using a Topaz signature pad and pen. Each
signature is embedded and bound solely to the text of the document. A change made to
any part of the text of the document after signing, even something as minimal as hitting the
spacebar or enter key, renders the signature invalid in order to protect the signer.
However, if the text is returned to the state it was in when the document was signed, the
signature will once again be considered valid. Please note that form fields (such as drop
down menus, radio buttons, etc.) are excluded from the binding process.

Please make sure you first install the current version of SigPlus:
www.topazsystems.com/sigplusproactivex.html

Then, install the plug-in at:
www.topazsystems.com/plugins.html

Signing in MS Word

Before you can sign, you must make sure that you are in “Print Layout”. To accomplish this,
go to the “View” menu and choose “Print Layout”. Once your document is ready to be
signed, click on the pencil icon, “Topaz: Sign Doc”. The icon can be found along the
toolbar at the top of the screen.

File Edit View Inset Format Tools Table Window Help
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If you open Word and don't see the “Topaz: Sign Doc” icon, click on “Tools” - “Templates
and Add-ins”. Inthe window that appears, you should see “TopazSig3.dot” listed. Make
sure it is checked and click “OK”. If you still cannot see the pencil icon, go to “View” >
“Toolbars”, and make sure “Topaz” is checked.
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The signing window will then be displayed once the “Sign Doc” icon is clicked.

r N
Sign Document &

Signature Select

YOU ARE CREATING A NEW SIGNATURE BOX Delete

Done | Clear Cancel

| | I mitials

| Type the name for this signature box here (optional): )
| v stamp

Once the signing window is open, there are a number of options a user can choose:

= “Cancel” will cancel the signature event.
= “Clear” will clear any signature in the signature window, allowing the user to sign again.
= “Done” will bind the signature to the document text and then embed it into the document.
» The user can name the signature by using the specified field, “Type the name for
the signature box here (optional)”, located below the buttons.
= Atime and date stamp can be included by checking the “Stamp” box in the lower right
hand corner.
» If the document requires initials instead of a signature, check the “Initials” box.
This will place a smaller signature field in the document.

Setting Macro Security

After installing the plug-in, a macro security warning may appear the first time you try to
open Word, depending on your security settings; “High” or “Medium” settings will prompt a
warning, while “Low” will not. The warning will reference “TopazSig3.dot”. Make sure that
“Always trust macros from this source.” is checked, and click on “Enable Macros”.

Security Warning @Q@

TopazSig3.dot

contains macros by Details...
Topaz Systems, Inc.

Macros may contain viruses. Itis always safe to disable macros, but if the
macros are legitimate, you might lose some functionality.

The security level is set to High. Therefore, you cannot enable macros
from sources that you do not trust.

[v {Always trust macros from this source. |

Disable Macros | Enable Macros More Info
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Once Word is open to a document, click on “Tools” = “Macro” - “Security”. In the
“Security Level” tab, make sure that macro security is set to “High”. Then, click on the
“Trusted Sources” tab. If you received the macro security warning when opening Word,

“Topaz Systems, Inc.” should now be listed as a trusted source.

In order for the new security settings to take effect, close and then reopen Word. If your
initial macro security setting was “Low”, you will receive the macro security warning upon

reopening Word. Follow the steps outlined above to enable macros.

Adding Topaz as a Trusted Publisher

In order to overcome the requirement to click-through “Enable Content” when Word is
opened, you can set-up Topaz Systems, Inc. as a trusted publisher in Word. Follow the
steps below to do so:

1) Open a new Word document, and click “Macros have been disabled” in the “Security
Warning” bar at the top.

| SECURITY WARNING Macros have been disabled. Enable Content

L

-

Click for more details

2) The “Info” window will appear. Click “Enable Contact” - “Advanced Options”.

Info

v

Enable
Content

Security Warning
Active content might contain viruses and other security hazards. The following
content has been disabled:
Macros
t the contents of the file.

Enable All Content
Enable all active content for this session only

Advanced Options
Select which active content should be enabled.
This content will be enabled for this session only.

o
Protect

| Control what types of changes people can make to this document.
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3) In the window that appears, select “Trust all documents from this publisher”.

Microsoft Office Security Options @

@ Security Alert - Macros

Macros

Macros have been disabled. Macros might contain viruses or other security
hazards. Do not enable this content unless you trust the source of this file,

Mote: The digital signature is valid, but the signature is from a publisher whom
you have not yet chosen to trust.

More information
File Path: CM..ram Files\Microsoft Office 15\ root\officel 5\STARTUP\TopazSig3.dot
Signature

Signed by: Topaz Systems, Inc.

Certificate expiration: 1/17/2019

Certificate issued by: Symantec Class 3 SHA256 Code Signing C&
Show Signature Details

) Help protect me from unknown content (recommended)
(7) Enable content for this session

@ Trust all documents from this publisher

Open the Trust Center [ OK ] [ Cancel ]

4) To ensure that Topaz Systems, Inc. has been added as a trusted publisher, check
your list of Trusted Publishers. Click “File” - “Options” - “Trust Center” - “Trust
Center Settings...” > “Trusted Publishers”.

Trust Center @

Trusted Publishers

Trusted Publishers
Trusted Locations

Issued To Issued By Expiration Date
Topaz Systems, Inc. Symantec Class 3 SHA256 Code Signing CA  1/17/2019

Trusted Documents
Trusted App Catalogs
Add-ins

ActiveX Settings
Macro Settings
Protected View
Message Bar

File Block Settings

Privacy Options

Signature Placement

When signing in MS Word, the signature’s bottom-left edge will be placed at the cursor
location. The signature’s height is automatically sized based on the amount of space
above the cursor before any text is reached. The plug-in sizes a signature using its
baseline as a reference, rather than its top edge. If the cursor is immediately beneath a
line of text, the plug-in will adjust its size to fit from the cursor up to the text above - only
one line - rather than using any available space below the cursor. To ensure that your
signatures are displayed at the proper size, make sure that you leave enough space
between the cursor and any page items appearing above it before signing.
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Electronic signatures can be a maximum size of 0.7 of an inch height and 3.5 inches in
width (For larger signatures, email support@topazsystems.com).

Before signing, the cursor is placed sufficiently below the last line of text, leaving room to
create a signature field.

Tools Table Window Help
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Here is some text.

After signing, the signature fits into the space provided.

Tools Table Window Help
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Here is some text.
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Each signature can be positioned by moving the cursor to the desired place in the
document, then going through the signing procedure above. Be sure to plan ahead for the
placement of your signature and create enough space to facilitate all necessary signatures
before the signing process is initiated. Bear in mind that pressing the “Space Bar” or the
“Enter Key” after signing will result in the invalidation of any previously-signed signature
fields.

Naming Signatures

The “Signature Select” box will list all the signatures already embedded in your document.
The names listed in this box will correspond to the name of a particular signature. If no
name was entered during signing, a default listing of SigPlus1, SigPlus2, etc. will be
displayed. Each signature’s name can also be found in the top right corner of each
signature field.

i ; EA Smith
.01 prin

When you highlight a particular signature’s name in the “Signature Select” box, you may
delete the signature by clicking the “Delete” button, or make a new signature by signing
again and clicking “Done”. Highlighting “New” in the “Signature Select” box will create a
new signature. If a user is unsure whether they are creating a new signature field or signing
a currently existing one, there is a message below the signature window that indicates the
function being performed.

Sign Document lﬁ

Signature Select

Signature 1
SigPlus2

YOU ARE CREATING A NEW SIGNATURE BOX Delete |
Done Clear Cancel

Typer the name for this signature box here (optjoné!)':

vV stamp
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Changing the Size of a Signature Field

“Design Mode”, found on the toolbar at the top of the screen, is a useful tool that can alter
the size and location of a signature field, blank or otherwise, to better fit the user’s needs.
To access “Design Mode”, click on “View” - “Toolbars” - “Control Toolbox”. The “Control
Toolbox” toolbar may already be available in the toolbar along the top of the screen.

To activate “Design Mode”, click on the “Design Mode” icon. In “Design Mode”, you can
now click on the signature field to position and size it. Holding the “Alt” key while
performing this will allow for fine-tuning. When finished, make sure to deactivate “Design
Mode” by clicking on the “Design Mode” icon.

Pre-Placing Blank Signature Fields

A user can also pre-place a blank signature field into a Word document by following these
steps:

1. Place the cursor in the general location of the desired signature position.

2. Click the “Sign Doc” icon to open the “Sign Document” window. If desired, the
user can name the signature and enable/disable the time stamp at this time
as well. Click the “Done” button without signing and a blank signature field will
be embedded in the document.

Tools Table Window Help
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Tools Table Window Help
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Here is some text. -
:::::

0171672015 041311 pen

'YOU ARE CREATING A NEW SIGNATURE BOX
lear |

ncel |
I Initials
Type the name for this signature box here (optional):

V stamp

To sign a blank signature field, click the “Sign Doc” icon. On the right hand side of the
“Sign Document” window, you will find the “Signature Select” box. Choose the blank
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signature field (SigPlusl, SigPlus2, or the user defined name) that you want to sign. Once
the proper blank signature has been chosen, sign and click “Done”.

The signature will be placed in the corresponding blank signature field.

JTools Table Window Help
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Here is some text.

EA Smith
HE] 1459 pm

The benefits of pre-placed blank signature fields include:

1. Consistent placement and size of signatures.
2. Ease of use as signature placement is independent of cursor position.
3. Dramatic reduction in time needed for signing process.

Validating Signatures

The “Validate Sig” button, located next to the “Sign Doc” button and denoted by a checkmark
icon, will check the validity of each signature in the document.
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If changes have been made to the textual contents of a document after signing has taken
place, the signature(s) will be rendered invalid and appear to be blank.

If a signature is invalid, the ONLY way to restore the signature to a valid state is to return
the document to the state it was in when signed and click “Validate Sig” again.

Note: Notice now the text has been restored to its original state; the signature has returned and
is once again in its valid state.

Here is some text.

EA Smith S ——————
W et
HEL: 1459 pm

All Signatures Valid (=22
1 Signature Valid, Document Receipt = e729dd95

Any change to the document can render a signature invalid, even a change as small as
adding a space after a sentence. The “Validate Sig” button can be clicked at any time
while the document is open, and should be clicked any time the user wants to know the
status of the signature(s).

A Topaz eSignature is original biometric data in secure encrypted form residing within the
“signature control” on the document. A Topaz eSignature is not an image captured by the
pad, and therefore cannot be copied and placed into another document. There is no way
to access the signature, ensuring security of both signatures and documents.

Any of the following events will trigger signature validation:

Pressing the “Validate Sig” button
Closing a document

Saving a document

Opening a document

Printing a document

arLODOE

Auto-Validation and Voided Signatures

Auto validation is a process performed automatically by the plug-in when a document is

opened. If multiple instances of Word are open, auto-validation does not occur, leaving any
signatures within the document invalid. Also, if you open a Word document through a third-
party document management system, you will need to press the “Validate Sig” button to run
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the validation. To manually validate the signatures, go to the “Add-ins” tab and click the
“Validate Sig” icon. A message will appear in Word, stating that the signature is either valid
or invalid. If the signature is valid, it will be restored to the document.

If the signature is invalid, a change was made to the document. The signature will not be
valid until the document has been restored to its original state.

An invalid signature will also lose the name it was assigned. If the Sign Doc icon is clicked,
the list of names under “Signature Select” will be replaced with Voidl, Void2, etc. The
document can be re-signed without it being restored to its original state, but the signature
name will default to SigPlusl, SigPlus2, etc., unless the name is re-entered in the “Type the
name for this signature box here” field.

~ 7 S
Sign Document &F Sign Document &

ignature Selec
New

Void1
Void2

ggnature Select
New
Signature 1
Signature 2

List of valid signature names List of invalid signature names

YOU ARE CREATING A NEW SIGNATURE BOX YOU ARE CREATING A NEW SIGNATURE BOX

Cancel ‘

Cancel | Done

Done
[ Initials

[ Initials

| Type the name for this signature box here (optional): | Type the name for this si§nature box here '(opﬁonal):
v stamp [V Stamp

Pre-placed blank signature fields that have never been signed will be named Voidl, Void2,
etc. before validation. However, their names will return after validation.

Location of the TOPAZSIG3.DOT File

The TopazSig3.dot file for MS Word is automatically installed into the location specified
by MS Office within the WIN registry. Most often this is in one of two locations,
depending on the current Operating System and version of Office:

<WIN\Application Data\Microsoft\Word\Startup>
<Program Files\MicrosoftOffice\Office\StartUp>

Installed this way, TopazSig3.dot is treated as a global template rather than a document
template, and as such, it is available to all Word documents. As a global template,
eSignature technology is available to any document you might have opened, saved, or
new, and at any time. This is the suggested method of electronic signatures using the
Topaz plug-ins. If you prefer you may make TopazSig3.dot a document template, however,
eSignature capability will be provided only for new documents that the user bases on the
Topaz template.
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To do this, cut or delete TopazSig3.dot from the aforementioned “Startup” folder and place
it in one of two locations, depending on the Operating System and version of office:

<Program Files\Microsoft Office\Templates>
<WIN\Application Data\Microsoft\Templates>

Troubleshooting Tips

1.

Q.

13

Do not use date fields when creating documents. Date fields can auto-update
when the document is opened. This will cause any signatures within the
document to become invalid. To avoid inadvertently invalidating signatures, it
is best to manually enter dates into a document.

After signing and clicking the “Done button” in the “Sign Doc” window, the
signature is not visible in the document, or the signature is so small that it is
illegible.

A.

Most likely, not enough space was left between the cursor and the above text
to place a signature field. Click the “Validate Sig” icon. A message stating
that the document contains a valid signature should appear. That confirms
that the signature is somewhere in the document, even though it is not
visible. Search through the document for the signature field. Often, it has
shrunk and is in the top left corner, on the first page of the document. If you
are having trouble finding the signature, go to the “Developer” tab, and click
on the “Design Mode” icon. This will put 4 dots around the edge of the
signature field, making it more visible. Once the signature is found, make
sure you are in “Design Mode”, and then drag/resize the signature.

If the signature cannot be found, you can go back to the “Add-ins” tab, click
the “Sign Doc” icon, select the missing signature, and click “Delete”. In the
document, place the cursor leaving enough room to create a signature field,
and re-sign the document.

After signing and clicking the “Done” button in the “Sign Doc” window,
no signature appears in the document.

A.

First, verify that a signature was created by clicking on the “Validate Sig”
icon. If a message appears that says, “No Valid Signature in
Document”, a signature was never created. Make sure that Word is in

“ Print Layout” by clicking “View” and selecting “Print Layout”. Now, click
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Q.

Q.

Q.
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the “Sign Doc” icon. “New” should appear in the “Signature Select”
box. If so, sign, name the signature if desired, and click “Done”. The
signature should appear in the document.

After signing and clicking the “Done” button in the “Sign Doc” window, the
signature shows up higher than the location where the cursor was placed.

A.

This indicates that the white space, normally seen between two pages in a
document, is hidden.

Click on “Tools” - “Options” = “View”, and check “White space between
pages”.

Exit out of the “Options” window and open the “Sign Doc” window from the
“Add-ins” tab. Select the affected signature, delete it, and re-sign the
document. When you click “Done”, the signature will appear in the correct
location.

Placing a signature inside a table:

A.

The best way to place a signature inside a table is to first place the cursor
somewhere in the document, outside of the table, with plenty of white
space. Go to the “Add-ins” tab, and click on the “Sign Doc” icon. Sign,
name the signature if desired, and click “Done”. Then, go the “Developer”
tab, and click on the “Design Mode” icon. You can now resize the
signature field and drag it into an existing table in the document.

Printing a signed document to a PDF:

A.

When printing a signed document to PDF, there is no guarantee that the
signatures within the document will be visible in the PDF. Additionally, once
the document is converted to a PDF, any visible signatures within that PDF
are no longer eSign compliant. This is because the distillation process from
Word document to Acrobat PDF has no means to process Topaz’s SigPlus
object, and will attempt to create an image based on the rendered signature.
To create eSign compliant signatures in a PDF, download the Topaz Adobe
Acrobat Plug-in and sign documents directly in Adobe Acrobat.
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Q. Sending a signed Word document to someone else:

A. If you want to send your signed Word document to someone else, that person
must install SigPlus, as well as the MS Office Plug-in. Without that software,
they may not be able to see the signature(s), and even if they can see them,
they will have no way of determining the validity of the signature(s).
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